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Abstrak  

Daerah - daerah di Jawa Timur khususnya Kabupaten Mojokerto, seiring berkembangnya jaman mengalami 

peningkatan pada sisi pertumbuhan perekonomian serta infrastruktur jalan raya, dampak dari peningkatan tersebut yakni 

juga semakin meningkatnya volume lalu lintas serta muatan (tonase) kendaraan pada beberapa ruas jalan terlebih pada 

ruas jalan Provinsi di Kabupaten Mojokerto. Analisis Kelas Jalan merupakan analisis yang bertujuan untuk 

pengelompokan atau mengklasifikasi suatu ruas jalan dengan penentuan klasifikasinya berdasarkan fungsi dan 

intensitas lalu lintas serta daya dukung menerima muatan sumbu terberat dan dimensi kendaraan bermotor. 

Metode penelitian yang digunakan pada penelitian ini dibagi menjadi beberapa tahap yaitu, Tahap survey, 

Pengumpulan data (Data Primer dan Data Sekunder), Pengolahan data, Pembuatan peta kelas jalan menggunakan 

ArcGIS dan Integrasi peta kelas jalan kedalam peta digital existing (Google Maps). Lokasi yang digunakan untuk 

penelitian atau analisis penyusunan kelas jalan ini dilakukan pada tiga ruas Jalan Provinsi yang berada di wilayah 

Kabupaten Mojokerto.  

Hasil dari analisis tersebut yakni, berdasarkan Peraturan Menteri Pekerjaan Umum dan Perumahan Rakyat No. 

05/PRT/M/2018 pada tiga ruas Jalan Provinsi tersebut direkomendasikan masuk pada kategori Kelas Jalan III. Ruas 

Jalan Provinsi tersebut sudah dilakukan proses untuk menjadikan peta kelas jalan sebagai peta digital, serta dapat 

diintegrasikan ke dalam Peta Digital Existing (Google Maps). 

 

Kata Kunci: Analisis Kelas Jalan, Kelas Jalan, Jalan Provinsi, ArcGIS, Google Maps. 

Abstract 

Regions in East Java, especially Mojokerto Regency, as the times have experienced an increase in terms of 

economic growth and road infrastructure, the impact of this increase is also the increasing volume of traffic and vehicle 

tonnage on several roads, especially on provincial roads in Mojokerto, Road Class analysis is an analysis that aims to 

classify or classify a road segment by determining its classification based on traffic function and intensity as well as 

carrying capacity to receive the heaviest axle loads and dimensions of motorized vehicles.  

The research method used in this study was divided into several stages, namely, the survey stage, data collection 

(Primary Data and Secondary Data), data processing, making road class maps using ArcGIS, and integrating road 

class maps into existing digital maps (Google Maps) . The location used for the research or analysis of the preparation 

of this class is carried out on three Provincial Road sections in the Mojokerto Regency area.  

The results of the analysis are, based on Minister of Public Works and Public Housing Regulation No. 05 / PRT / 

M / 2018 on the three Provincial Road sections it is recommended to be included in the Class III Road category. The 

Provincial Road Section has been carried out a process to make the road class map as a digital map, and can be 

integrated into the Existing Digital Map (Google Maps). 

KeyWords: Analysis of Road Classes, Road Classes, Provincial Roads, ArcGIS, Google Maps. 

 

PENDAHULUAN  

Jalan merupakan salah satu infrastruktur penting bagi 

manusia untuk dapat mencapai suatu daerah yang ingin 

dikehendaki. Pembuatan jalan raya bertujuan untuk 

pemerataan perekonomian suatu daerah dan sebagai jalur 

penghubung antara suatu daerah dengan daerah yang lain. 

Secara umum laju pertumbuhan dan perekonomian 

biasanya tidak terlepas dari tuntutan pengembangan 

wilayah yang akan membawa perubahan pada kondisi 

angkutan barang dan jasa yang semakin meningkat pula, 

baik volume kendaraan yang melintas maupun berat 

beban kendaraan (tonase), untuk mengatasi hal tersebut 

perlu dilakukan suatu perencanaan yang baik, yaitu 

meningkatkan infrastruktur dalam hal ini jalan raya, 

karena dengan adanya infrastruktur jalan yang berkualitas 

akan memperlancar distribusi barang dan jasa yang 

menyebabkan meningkatnya aksebilitas dan mobilitas 
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barang dan jasa yang selanjutnya mampu meningkatkan 

kesejahteraan masyarakat (Wahab, 2009). 

Daerah - daerah di Jawa Timur khususnya Kabupaten 

Mojokerto, seiring berkembangnya jaman mengalami 

peningkatan pada sisi pertumbuhan perekonomian serta 

infrastruktur jalan raya, dampak dari peningkatan tersebut 

yakni juga semakin meningkatnya volume lalu lintas 

serta muatan (tonase) kendaraan pada beberapa ruas jalan 

terlebih pada ruas jalan Provinsi di Kabupaten 

Mojokerto, berdasarkan hal tersebut maka Menteri 

Pekerjaan Umum dan Perumahan Rakyat (PUPR) 

menerbitkan Peraturan Menteri Pekerjaan Umum dan 

Perumahan Rakyat No. 05/PRT/M/2018 tentang 

“Penetapan Kelas Jalan Berdasarkan Fungsi dan 

Intensitas Lalu Lintas serta Daya Dukung Menerima 

Muatan Sumbu Terberat (MST)  dan Dimensi Kendaraan 

Bermotor.” Hal tersebut didukung juga oleh 2 (dua) 

Regulasi yang mengatur Kelas Jalan, yakni : 1) Undang-

Undang Republik Indonesia Nomor 22 Tahun 2009 

tentang Lalu Lintas dan Angkutan Jalan; jalan 

dikelompokkan dalam beberapa kelas, yaitu berdasarkan 

fungsi dan intensitas lalu lintas guna kepentingan 

pengaturan penggunaan jalan dan kelancaran lalu lintas 

dan angkutan jalan; dan daya dukung untuk menerima 

muatan sumbu terberat dan dimensi kendaraan bermotor. 

Adapun pengelompokkan jalan menurut kelas jalan 

tersebut terdiri atas jalan kelas I, jalan kelas II, jalan kelas 

III, dan jalan kelas khusus. 2) Peraturan Pemerintah 

Republik Indonesia Nomor 79 Tahun 2013; Ketentuan 

Lebih lanjut mengenai penyusunan kelas jalan diatur 

dengan peraturan menteri yang menyelenggarakan urusan 

pemerintahan di bidang jalan.   

Maksud dan tujuan dilakukannya analisis tersebut 

yaitu untuk mewujudkan tertib penyelenggaraan jalan 

serta pembinaan lalu lintas dan angkutan jalan; 

tersedianya Jalan yang berkeselamatan, berkemananan, 

lancar dan tertib; dan kepastian hukum dalam penentuan 

Kelas Jalan, karena The Asian Foundation (2009) 

menyatakan di Indonesia saat ini pengguna jalan pada 

umumnya tidak mematuhi batas Muatan Sumbu Terberat 

(MST), serta tidak sesuai dengan Kelas Jalan yang ada. 

Analisis Kelas Jalan merupakan analisis yang 

bertujuan untuk pengelompokan atau mengklasifikasi 

suatu ruas jalan dengan penentuan klasifikasinya 

berdasarkan fungsi dan intensitas lalu lintas serta daya 

dukung menerima muatan sumbu terberat dan dimensi 

kendaraan bermotor. Pada Analisis Kelas Jalan ini ruas 

jalan yang akan dianalisis yaitu Ruas Jalan Provinsi yang 

terletak di wilayah Kabupaten Mojokerto Provinsi Jawa 

Timur. 

 

 

METODE PENELITIAN 

A. Tahap Survey 

Pada Analisa Penyusunan dan Pemetaan Kelas Jalan 

pekerjaan yang dilakukan yaitu dimulai dari tahap 

Survey, adapun tahapan survey yang dilakukan antara 

lain : 

1) Melihat Lokasi yang akan diukur atau disurvey 

Dilakukan agar tahapan survey dapat dilakukan 

dengan baik ketika dilapangan. 

2) Menyiapkan Persiapan Alat 

Pada tahap ini kesiapan dan kelengkapan alat harus 

dilakukan dengan baik agar nantinya pada tahapan survey 

berjalan dengan lancar dan data hasil survey yang didapat 

lebih lengkap serta mendukung untuk pengolahan data 

(analisis). 

3) Melakukan Pengukuran/Survey 

Setelah dilakukan tahapan-tahapan sebelumnya, maka 

tahapan selanjutnya yaitu melakukan pengukuran/survey 

menggunakan alat-alat yang telah disiapkan ke lokasi 

penelitian. 

4) Pengolahan dan Output 

Setelah tahapan survey dilakukan maka tahapan 

selanjutnya yaitu pengolahan data hasil 

pengukuran/survey, data hasil pengukuran/survey 

nantinya akan digunakan untuk menganalisis Penyusunan 

dan Pemetaan Kelas Jalan Pada Jalan Provinsi. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Flow Chart Penelitian 
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B. Pengumpulan Data 

1) Data Primer 

Data primer, yaitu data yang diperoleh secara 

langsung dari sumbernya, data primer pada penelitian ini 

sebagai berikut : 

1. Peta Citra Satelit Kabupaten Mojokerto 

2. Batas Administrasi (Kabupaten dan Kecamatan) 

3. Jaringan Jalan di Kabupaten Mojokerto 

2) Data Sekunder 

Data Sekunder yang digunakan untuk menganalisa 

Kelas Jalan yaitu data Volume Lalu Lintas (LHR) dan 

Survei Inventarisasi Prasarana Jalan. Data-data tersebut 

diperoleh dari Konsultan Perencana yaitu PT. Mitra Cipta 

Engineering yang diberi wewenang oleh Dinas Pekerjaan 

Umum Bina Marga Provinsi Jawa Timur untuk 

melakukan pekerjaan Analisa Penentuan Kelas. 

 

C. Pengolahan Data 

Pengolahan data merupakan kegiatan untuk 

menentukan Kelas Jalan berdasarkan Peraturan Menteri 

Pekerjaan Umum dan Perumahan Rakyat (PUPR) No. 

05/PRT/M/2018, Tentang Penetapan Kelas Jalan 

Berdasarkan Fungsi dan Intensitas Lalu Lintas Serta 

Daya Dukung Menerima Muatan Sumbu Terberat dan 

Dimensi Kendaraan Bermotor, selain berdasarkan 

Permen PUPR Analisis Penyusunan Kelas Jalan juga 

mengacu dan berpedoman pada : 

a) Undang-Undang Republik Indonesia No. 22 Tahun 

2009, Tentang Lalu Lintas dan Angkutan Jalan. 

b) Peraturan Pemerintah Republik Indonesia No. 79 

Tahun 2013, Tentang Jaringan Lalu Lintas dan 

Angkutan Jalan. 

 

D. Pembuatan Peta Kelas Jalan menggunakan 

ArcGis 

Setelah dilakukan pengolaan data serta ditentukan 

Kelas Jalannya maka tahapan selanjutnya yaitu 

pembuatan peta berdasarkan Klasifikasi Kelas Jalan yang 

sudah dianalisa sebelumnya, pembuatan peta Kelas Jalan 

berupa memasukkan data-data kondisi Existing pada ruas 

jalan tersebut serta pemberian warna pada layer software 

ArcGis : 

a) Kelas Jalan I (Merah) 

b) Kelas Jalan II (Biru) 

c) Kelas Jalan III (Hijau). 

 

E. Integrasi Peta Kelas Jalan Kedalam Peta Digital 

Existing (Google Maps) 

Berdasarkan tujuan akhir dari penelitian ini yaitu 

menjadikan peta yang sudah digambar sebagai peta 

digital serta dapat diintegrasikan kedalam Google Maps. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2. Flow Chart Integrasi Peta Kelas Jalan 

Kedalam Peta Digital 

 

HASIL DAN PEMBAHASAN 

Pembahasan ini berisi analisis sesuai dengan rumusan 

masalah dan tujuan penelitian, cakupan dalam analisis ini 

meliputi Analisis Penyusunan Kelas Jalan pada tiga ruas 

jalan provinsi yang ada di Kabupaten Mojokerto serta 

pemetaan pada ruas jalan yang sudah dianalisa.  

A. Analisis Penyusunan Kelas Jalan 

1) Ruas Mojokerto – Gedek 

Ruas Jalan Mojokerto - Gedek merupakan ruas jalan 

yang berada dibagian utara Kabupaten Mojokerto, ruas 

jalan tersebut melewati dua Kecamatan yaitu Kecamatan 

Jetis dan Kecamatan Gedek. Ruas Jalan Mojokerto – 

Gedek memiliki status jalan sebagai Jalan Provinsi, 

memiliki panjang ruas jalan sepanjang ± 4,71 Kilometer 

dengan lebar jalan rata-rata 6 meter serta termasuk tipe 

jalan 2/2 UD (2 Jalur 2 Arah Tidak Terbagi), berdasarkan 

klasifikasi fungsi jalan pada ruas jalan tersebut 

dikategorikan sebagai fungsi jalan kolektor (kolektor 

primer) dikarenakan ruas jalan tersebut merupakan jalan 

umum yang berfungsi melayani angkutan atau kendaraan 

dengan perjalanan jarak sedang. 

Pada Ruas Jalan tersebut berdasarkan data yang 

didapat radius tikungan rata-ratanya sebesar 135 meter, 

dengan radius tikungan rata-rata sebesar 135 meter serta 

lebar jalan rata-rata 6 meter maka pada ruas jalan tersebut 

kecepatan rencana kendaraan yang akan melewati ruas 

jalan tersebut paling rendah (minimum) direncanakan 

sebesar 40 Km/Jam. 

 

Tabel 1. Rekapitulasi Volume Kendaraan  dengan 

Muatan Sumbu Terberat (MST) 10 Ton dari data Lalu 

Lintas Harian (LHR) Arah 1 (Mojokerto - Gedek)  
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 Tabel 2. Rekapitulasi Volume Kendaraan  dengan 

Muatan Sumbu Terberat (MST) 10 Ton dari data Lalu 

Lintas Harian (LHR) Arah 2 (Gedek - Mojokerto) 

 
 

Sedangkan untuk data Kendaraan dengan Muatan 

Sumbu Terberat (MST) 10 Ton pada ruas Jalan 

Mojokerto – Gedek didapat data sebanyak 570 

Kendaraan/Hari, dengan rincian dari arah 1 (Mojokerto – 

Gedek) sebanyak 324 Kendaraan/Hari dan dari arah 2 

(Gedek – Mojokerto) sebanyak 246 Kendaraan/Hari. 

 

2) Ruas Batas Kabupaten Lamongan – Gedek 

Ruas Jalan Batas Kabupaten Lamongan - Gedek 

merupakan ruas jalan yang berada dibagian utara 

Kabupaten Mojokerto, ruas jalan tersebut melewati empat 

Kecamatan sekaligus yaitu Kecamatan Dawarblandong 

,Kecamatan Kemlagi, Kecamatan Jetis dan Kecamatan 

Gedek. Ruas Jalan Batas Kabupaten Lamongan - Gedek 

memiliki status jalan sebagai Jalan Provinsi, memiliki 

panjang ruas jalan sepanjang ± 18,18 Kilometer dengan 

lebar jalan rata-rata 6,5 meter serta termasuk tipe jalan 

2/2 UD (2 Jalur 2 Arah Tidak Terbagi), berdasarkan 

klasifikasi fungsi jalan pada ruas jalan tersebut 

dikategorikan sebagai fungsi jalan kolektor (kolektor 

primer) dikarenakan ruas jalan tersebut merupakan jalan 

umum yang berfungsi melayani angkutan atau kendaraan 

dengan perjalanan jarak sedang. 

 

Tabel 3. Rekapitulasi Volume Berdasarkan Satuan Mobil 

Penumpang (SMP) dari data Lalu Lintas Harian (LHR) 

Arah 2 (Gedek - Batas Kabupaten Lamongan) 

 
Tabel 4. Rekapitulasi Volume Kendaraan  dengan 

Muatan Sumbu Terberat (MST) 10 Ton dari data Lalu 

Lintas Harian (LHR) Arah 2 (Gedek - Batas Kabupaten 

Lamongan)

 

Pada Ruas Jalan tersebut berdasarkan data yang 

didapat radius tikungan rata-ratanya sebesar 110 meter, 

dengan radius tikungan rata-rata sebesar 110 meter serta 

lebar jalan rata-rata 6,5 meter maka pada ruas jalan 

tersebut kecepatan rencana kendaraan yang akan 

melewati ruas jalan tersebut paling rendah (minimum) 

direncanakan sebesar 40 Km/Jam.  

Sedangkan untuk data Kendaraan dengan Muatan 

Sumbu Terberat (MST) 10 Ton pada ruas Jalan Batas 

Kabupaten Lamongan - Gedek didapat data sebanyak 262 

Kendaraan/Hari, dengan rincian dari arah 1 (Batas 

Kabupaten Lamongan - Gedek) sebanyak 132 

Kendaraan/Hari dan dari arah 2 (Gedek - Batas 

Kabupaten Lamongan) sebanyak 130 Kendaraan/Hari. 

 

3) Ruas Gedek – Batas Kabupaten Jombang 

Ruas Jalan Gedek – Batas Kabupaten Jombang 

merupakan ruas jalan yang berada dibagian utara 

Kabupaten Mojokerto, ruas jalan tersebut melewati dua 

Kecamatan yaitu Kecamatan Kemlagi dan Kecamatan 

Gedek. Ruas Jalan Gedek – Batas Kabupaten Jombang 

memiliki status jalan sebagai Jalan Provinsi, memiliki 

panjang ruas jalan sepanjang ± 7,16 Kilometer dengan 

lebar jalan rata-rata 6 meter serta termasuk tipe jalan 2/2 

UD (2 Jalur 2 Arah Tidak Terbagi), berdasarkan 

klasifikasi fungsi jalan pada ruas jalan tersebut 

dikategorikan sebagai fungsi jalan kolektor (kolektor 

primer) dikarenakan ruas jalan tersebut merupakan jalan 

umum yang berfungsi melayani angkutan atau kendaraan 

dengan perjalanan jarak sedang. 

 

Tabel 5. Rekapitulasi Volume Kendaraan  dengan 

Muatan Sumbu Terberat (MST) 10 Ton dari data Lalu 

Lintas Harian (LHR) Arah 1 (Gedek – Batas Kabupaten 

Jombang) 

 
Tabel 6. Rekapitulasi Volume Kendaraan  dengan 

Muatan Sumbu Terberat (MST) 10 Ton dari data Lalu 

Lintas Harian (LHR) Arah 2 (Batas Kabupaten Jombang 

- Gedek) 

 

Pada Ruas Jalan tersebut berdasarkan data yang 

didapat radius tikungan rata-ratanya sebesar 120 meter, 

dengan radius tikungan rata-rata sebesar 120 meter serta 
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lebar jalan rata-rata 6 meter maka pada ruas jalan tersebut 

kecepatan rencana kendaraan yang akan melewati ruas 

jalan tersebut paling rendah (minimum) direncanakan 

sebesar 40 Km/Jam.  

Sedangkan untuk data Kendaraan dengan Muatan 

Sumbu Terberat (MST) 10 Ton pada ruas Jalan Gedek – 

Batas Kabupaten Jombang didapat data sebanyak 373 

Kendaraan/Hari, dengan rincian dari arah 1 (Gedek – 

Batas Kabupaten Jombang) sebanyak 234 

Kendaraan/Hari dan dari arah 2 (Batas Kabupaten 

Jombang - Gedek) sebanyak 139 Kendaraan/Hari. 

 

B. Pemetaan Kelas Jalan 

Pemetaan kelas jalan dalam penelitian ini 

menggunakan Software ArcGIS dengan versi 10.6.1, 

dimana versi tersebut merupakan versi paling baru 

(terupdate). Proses pemetaan kelas jalan dibagi menjadi 

tiga tahap , yaitu : 

1. Tahap Awal 

Pada tahap awal ini kegiatan yang dilakukan yaitu 

kegiatan persiapan, dimulai dari menyiapkan data-data 

spasial yang akan digunakan sebagai data untuk 

penggambaran peta kelas jalan, setelah data spasial sudah 

dirasa siap untuk pekerjaan pemetaan kelas jalan maka 

proses selanjutnya yaitu membuka Software ArcGIS pada 

PC/Laptop. 

 
Gambar 3. Tahapan membuka Program Software ArcGIS 

10.6.1 

Langkah Selanjutnya Setelah Program Software 

ArcGIS 10.6.1 dibuka dengan cara seperti gambar diatas, 

maka proses selanjutnya yaitu mengatur ukuran kertas 

yang akan digunakan pada Toolbar File, perintah untuk 

mengatur ukuran kertas yaitu klik File > Page and Print 

Setup, kertas yang digunakan untuk proses penggambaran 

peta kelas jalan yaitu kertas dengan ukuran A3 (297 x 

420 mm) > Ok. 

 
Gambar 4. Mengatur Ukuran Kertas Pada ArcGIS 10.6.1 

 

Setelah mengatur ukuran kertas menjadi A3, Langkah 

Selanjutnya yaitu menyesuaikan koordinat pada data 

spasial yang akan ditambahkan, dalam penelitian ini 

sistem koordinat yang dipakai yaitu sistem koordinat 

Universal Transverse Mercator (UTM) Zone 49S. 

Perintah untuk menyesuaikan koordinat yaitu Klik 

Toolbar Catalogs > Klik Kanan Folder Connections > 

Connect To Folder >  Pilih Folder yang ingin diconnect 

> Ok > Klik Folder yang sudah connect > Klik kanan 

pada Data yang telah ditambahkan > Klik Properties > 

Klik Tab XY Coordinate System > Klik WGS 1984 UTM 

Zone 49S > Ok. 

 
Gambar 5. Mengatur Sistem Koordinat Pada ArcGIS 

10.6.1 

Setelah koordinat pada ArcGIS diatur menjadi sistem 

koordinat Universal Transverse Mercator (UTM) Zone 

49S, langkah selanjutnya yaitu memasukkan data-data 

spasial ke dalam software dengan menggunakan toolbar 

add data, data spasial yang akan ditambahkan dalam 

pemetaan kelas jalan seperti data spasial dengan format 

ecw (Enhanced Compression Wavelet) sebagai data dasar 

pembuatan peta serta shp (shapefile) sebagai output peta 

kelas jalan, Toolbar yang digunakan yaitu Toolbar Add 

Data, dengan perintah Klik Add Data > Pilih Data 

Spasial yang akan digunakan Klik Add.     
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Gambar 6.  Menambahkan Data Pada ArcGIS 10.6.1 

 

2. Tahap Digitasi 

Proses selanjutnya setelah tahap awal yaitu tahap 

digitasi, Tahap digitasi yaitu merupakan tahap dimana 

proses penggambaran peta dilakukan dalam software 

ArcGIS, pada penggambaran peta dalam software ArcGIS 

menggunakan dua format file yaitu ecw (Enhanced 

Compression Wavelet) dan shp (shapefile), untuk nama 

file dengan format ecw dan shp dapat dilihat pada 

Gambar 3.4 File yang berformat ecw merupakan data 

dasar untuk membuat peta Jalan Provinsi (shp), file 

tersebut berupa citra satelit Kabupaten Mojokerto, 

sedangkan file yang berformat shp merupakan data 

pendukung (Batas Administrasi dan Jaringan Jalan 

Kabupaten) serta output (Jalan Provinsi). 

 
Gambar 7. Menambahkan Shapefile Pada ArcGIS 10.6.1 

 

Proses digitasi peta yaitu langkah pertama buat 

shapefile (shp) dengan klik Catalog pada pojok kanan 

ArcGIS > Klik pada folder yang sudah disiapkan (Data 

Kelas Jalan GIS) > Klik Kanan pada folder tersebut > 

Klik New > Klik Shapefile > Buat nama shapefile 

menjadi Jalan_Provinsi_Kab_Mojokerto > Feature Type 

Polyline (karena kita akan mendigitasi sebuah garis) > 

Atur koordinat menjadi WGS_1984_UTM_Zone_49s > 

Ok. Setelah shapefile dibuat maka selanjutnya 

menambahkan shapefile tersebut ke dalam ArcGIS. 

Proses selanjutnya yaitu dimulainya tahap digitasi 

Jalan Provinsi dengan klik kanan pada Jalan Provinsi > 

Edit Features > Start Editing, karena ketika kita memulai 

proses digitasi peta harus dalam posisi start editing, 

kemudian klik create features > pilih 

Jalan_Provinsi_Kab_Mojokerto > lalu klik straight 

segmented > proses digitasi peta dapat dilakukan dengan 

cara menyesuaikan polyline Jalan Provinsi dengan data 

dasar yaitu Citra Satelit Kabupaten Mojokerto. 

 
Gambar 8. Proses Digitasi Peta Jalan Provinsi Pada 

ArcGIS 10.6.1 

Setelah proses digitasi peta selesai dan menghasilkan 

shp berupa polyline pada Jalan Provinsi, proses 

selanjutnya yaitu mengedit simbol pada data spasial yang 

sebelumnya telah ditambahkan dan telah didigitasi, agar 

tampilan data spasial tersebut lebih mudah dibedakan dan 

dapat dipahami dibandingkan dengan data spasial yang 

lain, terlebih simbol data spasial tersebut akan ada pada 

legenda di Layout Peta Kelas Jalan (Printout) nantinya, 

simbol-simbol tersebut bisa berupa garis menerus 

maupun garis putus-putus serta bisa juga ditambahkan 

warna sesuai kebutuhan. 

Gambar 9. Jalan Provinsi (Warna Oranye) yang selesai 

didigitasi dengan data dasar Citra Satelit Mojokerto 

 

3. Tahap Akhir  

Pada tahap akhir pemetaan kelas jalan  menggunakan 

ArcMap lebih kepada penyempurnaan hasil peta sehingga 

ketika hasil peta dicetak atau diprint, diharapkan hasil 

peta tersebut lebih mudah dipahami dan lebih indah 

dilihat. Penyempurnaan hasil peta dapat berupa : 

1. Membuat Layout Peta. 

2. Menambahkan Judul Peta. 

3. Menambahkan Grid pada Peta. 

4. Menambahkan Skala Peta. 
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5. Menambahkan Arah Mata Angin. 

6. Menambahkan Legenda 

7. Menambahkan keterangan yang dirasa penting pada 

tampilan peta. 

C. Pembahasan 

1. Penyusunan Kelas Jalan 

Kelas jalan merupakan pengelompokan jalan 

berdasarkan fungsi, intensitas lalu lintas, daya dukung 

untuk menerima muatan sumbu terberat, dan dimensi 

kendaraan bermotor (Permen PUPR No. 

05/PRT/M/2018). Analisis Kelas Jalan merupakan 

analisis suatu ruas jalan sesuai persyaratan teknis yang 

ada, dalam penelitian ini persyaratan teknis dalam 

menyusun kelas jalan berdasarkan Peraturan Menteri 

Pekerjaan Umum dan Perumahan Rakyat No. 

05/PRT/M/2018. 

Setelah dilakukan analisis penyusunan kelas jalan 

pada masing-masing ruas Jalan Provinsi (Mojokerto - 

Gedek, Bts Kab. Lamongan – Gedek, Gedek – Bts. Kab. 

Jombang), Maka tahap selanjutnya yaitu penyusunan 

kelas jalan pada tiga ruas Jalan Provinsi tersebut 

berdasarkan Peraturan Menteri Pekerjaan Umum dan 

Perumahan Rakyat No. 05/PRT/M/2018. 

a) Penyusunan Kelas Jalan pada Ruas Jalan 

Mojokerto - Gedeg 

Pada analisa kelas jalan pada ruas jalan 

Mojokerto – Gedeg data-data yang didapat akan 

ditampilkan sebagai berikut : 

1) Nomor Ruas  : 163 

2) Panjang Ruas   : 4,71 Kilometer 

3) Lebar Jalan  : 6 Meter 

4) Kelandaian Memanjang : 2 % 

5) Tipe Jalan   : 2/2 UD 

6) Fungsi Jalan   : Kolektor Primer 

7) Radius Tikungan  : 135 m 

8) Kecepatan Rencana  : 40 Km/Jam 

  (minimum) 

9) Lalu Lintas Harian (LHR) : 20.904 Kendaraan  

   /Hari 

10) ∑ Kendaran MST 10 Ton : 2,727% dari LHR 

11) Mampu dilalui MST 8 Ton ? : Mampu 

Berdasarkan data-data diatas serta dibandingkan 

dan dianalisa dengan parameter-parameter 

persyaratan teknis pada Peraturan Menteri Pekerjaan 

Umum dan Perumahan Rakyat No. 05/PRT/M/2018, 

maka pada Jalan Provinsi dengan ruas Jalan 

Mojokerto – Gedeg direkomendasikan masuk pada 

kategori Kelas Jalan III. 

 

 

 

 

b) Penyusunan Kelas Jalan pada Ruas Jalan Batas 

Kabupaten Lamongan – Gedeg 

. Pada analisa kelas jalan pada ruas jalan Batas 

Kabupaten Lamongan - Gedeg data-data yang didapat 

akan ditampilkan sebagai berikut : 

1) Nomor Ruas  : 164 

2) Panjang Ruas   : 18,18 Kilometer 

3) Lebar Jalan  : 6,5 Meter 

4) Kelandaian Memanjang : 2 % 

5) Tipe Jalan   : 2/2 UD 

6) Fungsi Jalan   : Kolektor Primer 

7) Radius Tikungan  : 110 m 

8) Kecepatan Rencana  : 40 Km/Jam 

  (minimum) 

9) Lalu Lintas Harian (LHR) : 27.989 Kendaraan 

       /Hari 

10) ∑ Kendaran MST 10 Ton : 0,936% dari LHR 

11) Mampu dilalui MST 8 Ton ? : Mampu 

Berdasarkan data-data diatas serta dibandingkan 

dan dianalisa dengan parameter-parameter 

persyaratan teknis pada Peraturan Menteri Pekerjaan 

Umum dan Perumahan Rakyat No. 05/PRT/M/2018, 

maka pada Jalan Provinsi dengan ruas Jalan Batas 

Kabupaten Lamongan - Gedeg direkomendasikan 

masuk pada kategori Kelas Jalan III.  

 

c) Penyusunan Kelas Jalan pada Ruas Jalan Gedeg – 

Batas Kabupaten Jombang 

Pada analisa kelas jalan pada ruas jalan Gedeg – 

Batas kabupaten Jombang data-data yang didapat 

akan ditampilkan sebagai berikut : 

1) Nomor Ruas  : 165 

2) Panjang Ruas   : 7,16 Kilometer 

3) Lebar Jalan  : 6 Meter 

4) Kelandaian Memanjang  : 2 % 

5) Tipe Jalan   : 2/2 UD 

6) Fungsi Jalan   : Kolektor Primer 

7) Radius Tikungan  : 120 m 

8) Kecepatan Rencana  : 40 Km/Jam 

                         (minimum) 

9) Lalu Lintas Harian (LHR) : 33.839 Kendaraan 

                                                            /Hari 

10) ∑ Kendaran MST 10 Ton : 1,138% dari LHR 

11) Mampu dilalui MST 8 Ton ? : Mampu 

Berdasarkan data-data diatas serta dibandingkan 

dan dianalisa dengan parameter-parameter 

persyaratan teknis pada Peraturan Menteri Pekerjaan 

Umum dan Perumahan Rakyat No. 05/PRT/M/2018, 

maka pada Jalan Provinsi dengan ruas Jalan Gedeg – 

Batas Kabupaten Jombang direkomendasikan masuk 

pada kategori Kelas Jalan III. 
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2. Pemetaan Kelas Jalan 

Setelah tahap analisa penyusunan kelas jalan dan 

masing-masing ruas pada Jalan Provinsi diketahui kelas 

jalannya maka tahap selanjutnya yaitu editing Data 

Atribut pada data spasial yang sudah digitasi (Jalan 

Provinsi) yang sudah dianalisa, menggunakan software 

ArcGIS. 

a) Editing Data Atribut (Symbology) 

Data spasial yang sudah terdigitasi (Jalan 

Provinsi) akan menjadi warna default (random) pada 

ArcGIS, maka diperlukan editing data atribut agar 

atribut (simbol) pada data lebih jelas dan lebih mudah 

dipahami. Editing data atribut pada penelitian ini 

memakai pedoman dari Peraturan Menteri Pekerjaan 

Umum dan Perumahan Rakyat Nomor 

25/PRT/M/2014 Tentang “Penyelengaraan Data dan 

Informasi Geospasial Infrastruktur Bidang Pekerjaan 

Umum Dan Perumahan Rakyat”. 

Proses editing data atribut pada software ArcGIS 

ini mengambil contoh editing data atribut (simbology) 

pada Jalan Provinsi, perintah untuk edit data atribut 

yaitu Klik kanan data atribut pada Table Of Contens 

(TOC) > Properties > Akan tampil jendela Layer 

Properties > Klik Tab Symbology > Klik Features > 

Klik kotak pada bagian Symbol > Klik Edit Symbol > 

Ganti Units menjadi Milimeters > Ganti warna (RGB 

255,0,0) > Atur tebal garis (Width = 0,5 mm) > Ok. 

Ulangi langkah tersebut untuk edit data atribut 

(symbology) pada data atribut lainnya sesuai Permen 

PUPR No. 25/PRT/M/2014. 

 

 
Gambar 10. Proses Editing Data Atribut (Symbology) 

 

b) Add Field pada Data Atribut 

Proses selanjutnya setelah Editing Data Atribut 

(Symbology) yaitu Add Field, dimana Add Field 

merupakan penambahan kolom isian (Field) pada data 

atribut untuk memberikan informasi lebih lengkap 

tentang data-data eksisting yang akan ditampilkan 

pada Atributte Table, Nama Field pada pemetaan 

kelas jalan lebih kepada data-data kondisi eksisting 

yang diperoleh baik dari data primer maupun 

sekunder pada ruas jalan tersebut seperti yang 

dijelaskan pada Persyaratan Teknis Kelas Jalan 

(Permen PUPR No. 05/PRT/M/2018)  

Tabel 7. Kamus Data Pemetaan Kelas Jalan 

 

.  

 

 

Dalam Add Field kita juga harus mensetting 

Field Type (Text, Short Integrer, dan Double) serta 

Lebar Field yang akan kita tambahkan ke dalam 

attribute table. Nama Field (shp) pada attribute table 

hanya mampu menampung maksimal 10 huruf saja 

sehingga pada proses Add Field, Nama Field pada 

attribute table Pemetaan Kelas Jalan atau yang biasa 

disebut kamus data dapat dilihat pada Tabel 3.7. 

 Setelah kamus data disusun maka proses 

selanjutnya yaitu Add Field pada Data Atribut. Proses 

Add Field pada Data Atribut dapat dilakukan dengan 

perintah Klik kanan data atribut pada TOC > Klik 

Open Attribute Table > Akan tampil jendela Table > 

Klik Table Option > Pilih Add Field > Akan tampil 

jendela Add Field > Isikan pada baris Name sesuai 

Nama Field (shp) pada kamus data > Pilih Type Field 

> Isi Field Properties sesuai lebar field pada kamus 

data > Ok. 

  
Gambar 11. Proses Add Field pada Data Atribut 
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c) Mengisi Field pada Data Atribut 

Setelah dilakukan proses Add Field pada Data 

Atribut maka tahap selanjutnya yaitu pengisian data 

pada Field yang telah ditambahkan. Pengisian data 

pada field berdasarkan hasil survey lapangan dan hasil 

analisa penyusunan Kelas Jalan dan hanya dilakukan 

pada 3 Ruas Jalan Provinsi (Ruas Nomor 163, 164, 

165) dari total 12 Ruas Jalan Provinsi pada Kabupaten 

Mojokerto. 

 
Gambar 12. Field pada Data Attribut yang telah diisi 

sesuai hasil survey dan hasil analisa 

 

Proses pengisian Field pada Data Atribut dapat 

dilakukan dengan perintah Klik kanan data atribut 

pada TOC “Jalan Provinsi Kab. Mojokerto” > Klik 

Edit Features > Klik Start Editing, Setelah dalam 

proses Start Editing, Klik Kanan data Atribut pada 

TOC lagi > Klik Open Attribute Table > Isi Field 

sesuai data-data berdasarkan hasil survey dan hasil 

analisa > Klik editor > Save Editing > Stop Editing. 

 

d) Symbology Pada Data Attribut 

Tujuan akhir pada proses pemetaan kelas jalan 

menggunakan Software ArcGIS yaitu diketahuinya 

kelas jalan pada Ruas Jalan Provinsi tersebut. 

Untuk mengetahui kelas jalan pada masing-

masing Ruas Jalan tersebut maka dilakukan 

symbology pada data atribut, dimana symbology 

tersebut berupa pemberian warna layer pada data 

atribut Jalan Provinsi, warna layer untuk symbology 

kelas jalan yaitu :  

a) Kelas Jalan I (            ) 

b) Kelas Jalan II (            ) 

c) Kelas Jalan III (            ) 

 
Gambar 13. Proses Symbology pada Data Atribut 

Proses symbology pada data atribut dapat 

dilakukan dengan perintah Klik Kanan pada atribut 

“Jalan Provinsi Kab. Mojokerto” > Properties > Klik 

Tab Symbology > Klik Categories > Klik Unique 

Values > Pada Value Field pilih Kelas_Jln > Klik Add 

Values > Pada “Select the value(s) to add” klik “3” 

(karena dalam penelitian ini hasil analisa kelas jalan 

pada 3 ruas jalan provinsi yaitu Kelas Jalan III semua) 

> Ok > Klik dua kali pada garis sebelah “3” > Ganti 

sesuai symbology kelas jalan yaitu warna hijau > Ok. 

Setelah dilakukan proses diatas maka dapat diketahui 

kelas jalan pada ruas jalan tersebut. 

 

e) Integrasi Peta Kelas Jalan kedalam Peta Digital 

Existing (Google Maps) 

Proses terakhir dalam Analisis Penyusunan dan 

Pemetaan Kelas Jalan yaitu menjadikan peta yang 

sudah dianalisa dan digambar sebagai peta digital 

serta dapat diintegrasikan kedalam peta digital 

existing atau google maps.  

Proses konversi file dapat dilakukan pada Tools 

ArcToolbox > Klik Conversion Tools > Klik To KML 

> Klik dua kali Layer To KML, akan tampil jendela 

Layer To KML > Pilih layer yang akan diconvert 

dalam kasus ini layer yang akan diconvert ke KMZ 

yaitu layer Jalan Provinsi Kab. Mojokerto > Buat 

nama file KMZ serta pilih directori penyimpanan file  

> Save > Ok > Tunggu proses convert sampai selesai. 

 
Gambar 14. Proses Conversion dari SHP ke 

KML/KMZ 

Setelah proses conversion dari SHP ke 

KML/KMZ dilakukan maka proses selanjutnya yaitu 

membuka akun email pada www.gmail.com dengan 

menggunakan akun email : skripsi.ts14@gmail.com 

dengan password : skripsihabil14 > setelah login 

email searching menggunakan browser ke 

www.gmaps.com > Setelah masuk ke 

www.gmaps.com klik menu (      )  > Klik Tempat 

Anda (     ) > Klik Peta > Klik Buat Peta > Klik Impor 

> Pilih file yang akan diimpor (Jalan Provinsi Kab. 

Mojokerto) > Jika proses impor berhasil dan maka 

http://www.gmail.com/
mailto:skripsi.ts14@gmail.com
http://www.gmaps.com/
http://www.gmaps.com/
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proses integrasi peta kelas jalan yang sudah dianalisa 

dan digambar berhasil dilakukan.  

Cara mengetahui informasi pada ruas jalan 

tersebut berdasarkan hasil survey dan hasil analisa 

kelas jalan dapat dilakukan dengan mengklik no ruas 

pada jendela yang ada atau klik pada ruas jalannya,  

 
Gambar 15. Tampilan pada google map setelah 

integrasi peta kelas jalan berhasil dilakukan 

 

f) Integrasi Peta Kelas Jalan kedalam Peta Digital 

Existing (Google Maps) 

Fungsi dan tujuan dari dibuatnya peta kelas jalan 

yang sudah terintegrasi kedalam peta digital, yaitu 

agar  nantinya para pengguna jalan khususnya 

pengguna jalan yang berkendara dengan memakai 

kendaraan angkutan barang dengan berat minimal 8 

ton, lebih mudah memahami serta memperhatikan 

jalur mana saja yang boleh dilewati maupun yang 

tidak boleh dilewati oleh kendaraan angkutan barang 

tersebut, dengan memperhatikan keterangan-

keterangan pada peta digital Kelas Jalan pada Ruas 

Jalan Provinsi yang akan dilewati terutama pada 

keterangan “Mampu_8Ton” dan “Kelas_Jln”. 

Akses untuk membuka Peta Digital Kelas jalan 

sangatlah mudah, hanya bermodalkan 

handphone/smartphone para pengguna jalan yang 

akan melewati Ruas Jalan Provinsi tersebut  dapat 

dengan mudah membuka Peta Digital dengan 

mengakses www.gmaps.com 

Langkah-langkah untuk membuka Peta Digital 

Kelas Jalan pada handphone/smartphone yaitu 

dengan membuka akun email pada www.gmail.com 

dengan menggunakan akun email : 

skripsi.ts14@gmail.com dengan password : 

skripsihabil14 > setelah login email searching 

menggunakan browser ke www.gmaps.com > Setelah 

masuk ke www.gmaps.com klik menu (    )  > Klik 

Tempat Anda (      ) > Klik Peta > Klik Peta Kelas 

Jalan > Peta Kelas Kab. Mojokerto > Selesai. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 16. Tampilan Peta Digital Existing setelah 

berhasil dibuka pada Handphone/Smarpthone 

SIMPULAN 

Hasil dari analisis yang telah dilakukan menghasilkan 

kesimpulan, bahwa : 

1. Setelah dilakukan analisis kelas jalan berdasarkan 

Peraturan Menteri Pekerjaan Umum dan Perumahan 

Rakyat No. 05/PRT/M/2018 pada ruas jalan Provinsi 

yang berada di wilayah Kabupaten Mojokerto, yaitu 

pada ruas : 

a) Mojokerto - Gedek (No. ruas 163, panjang ruas 

4,71 Km) 

b) Bts Kab. Lamongan - Gedek (No. ruas 164, 

panjang ruas 18,18 Km) 

c) Gedek – Bts. Kab. Jombang (No. ruas 165, 

panjang ruas 7,16 Km) 

Maka didapat hasil dari analisis tersebut yakni, pada 

tiga ruas Jalan Provinsi tersebut direkomendasikan 

masuk pada kategori Kelas Jalan III. 

2. Ruas Jalan Provinsi yang telah dianalisis kelas 

jalannya sudah dilakukan proses untuk menjadikan 

peta kelas jalan tersebut sebagai peta digital, serta 

dapat diintegrasikan ke dalam Peta Digital Existing 

(Google Maps), dengan menggunakan media email 

(gmail) sebagai perantara penyimpanan file atau 

database. Peta Kelas Jalan berbasis Peta Digital dapat 

diakses pada website www.gmaps.com, dengan 

terlebih dahulu login email pada website 

www.gmail.com, login menggunakan email : 

skripsi.ts14@gmail.com dengan password : 

skripsihabil14. 

 

 

 

 

 

http://www.gmaps.com/
http://www.gmail.com/
mailto:skripsi.ts14@gmail.com
http://www.gmaps.com/
http://www.gmaps.com/
http://www.gmaps.com/
http://www.gmail.com/
mailto:skripsi.ts14@gmail.com
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